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ゾーンの設定と管理

ゾーン分割により、ストレージ デバイス間またはユーザ グループ間のアクセス制御の設定が可能にな

ります。ファブリックで管理者権限を持つユーザは、ゾーンを作成して、ネットワーク セキュリティ

を強化し、データ損失またはデータ破壊を防止することができます。ゾーン分割は、発信元 /宛先 ID 
フィールドを検証することによって実行されます。

FC-GS-4 および FC-SW-3 標準で指定された高度なゾーン分割機能が提供されています。既存の基本

ゾーン分割機能を使用したり、高度な標準準拠のゾーン分割機能を使用できます。

この章の内容は、次のとおりです。

• 「ゾーン分割の概要」（P.5-2）

• 「Quick Config ウィザードの使用」（P.5-7）

• 「ゾーン設定」（P.5-11）

• 「ゾーン セット」（P.5-16）

• 「ゾーン セット配信」（P.5-28）

• 「ゾーン セット配信」（P.5-32）

• 「詳細なゾーン属性」（P.5-40）

• 「ゾーン情報の表示」（P.5-48）

• 「拡張ゾーン分割」（P.5-49）

• 「ダウングレード用のゾーン データベースの圧縮」（P.5-54）

• 「デフォルト設定」（P.5-54）

（注） 表 2-1（P.2-4）に、ゾーンと VSAN の主な相違点を示します。
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ゾーン分割の概要
ゾーン分割には、次の機能があります。

• 1 つのゾーンは、複数のゾーン メンバーから構成されます。

– ゾーンのメンバー同士はアクセスできますが、異なるゾーンのメンバー同士はアクセスできま

せん。

– ゾーン分割がアクティブでない場合、すべてのデバイスがデフォルト ゾーンのメンバーとな

ります。

– ゾーン分割がアクティブの場合、アクティブ ゾーン（アクティブ ゾーン セットに含まれる

ゾーン）にないデバイスがデフォルト ゾーンのメンバーとなります。

– ゾーンのサイズを変更できます。

– 2 つ以上のゾーンにデバイスが所属することができます。

– 物理ファブリックには、最大 16,000 のメンバー を設定できます。これには、ファブリック内

のすべての VSAN が含まれます。

• ゾーン セットは、1 つまたは複数のゾーンで構成されます。

– ゾーン セットは、単一エンティティとしてファブリックのすべてのスイッチでアクティブま

たは非アクティブにできます。

– アクティブにできるのは、常に 1 つのゾーン セットだけです。

– ゾーンを 2 つ以上のゾーン セットのメンバーにすることができます。

– ゾーン スイッチあたりの最大ゾーン セット数は 500 です。

• ゾーン分割は、ファブリックの任意のスイッチから管理できます。

– 任意のスイッチからゾーンをアクティブにする場合、ファブリックのすべてのスイッチがアク

ティブ ゾーン セットを受信します。また、ファブリック内のすべてのスイッチにフル ゾーン 
セットが配信されます（この機能が発信元スイッチでイネーブルである場合）。

– 既存のファブリックに新しいスイッチが追加されると、新しいスイッチによってゾーン セッ

トが取得されます。

• ゾーンの変更を中断せずに設定できます。影響を受けないポートまたはデバイスのトラフィックを

中断させることなく、新しいゾーンおよびゾーン セットをアクティブにできます。

• ゾーン メンバシップ基準は、WWN または FC ID に基づきます。

– Port World Wide Name（pWWN）：スイッチに接続された N ポートの pWWN をゾーンのメン

バーとして指定します。

– ファブリック pWWN：ファブリック ポート（スイッチ ポートの WWN）の WWN を指定し

ます。このメンバシップは、ポートベース ゾーン分割ともいいます。

– FC ID：スイッチに接続された N ポートの FC ID をゾーンのメンバーとして指定します。

– インターフェイスおよび Switch WWN（sWWN）：sWWN によって識別されたスイッチのイ

ンターフェイスを指定します。このメンバシップは、インターフェイスベース ゾーン分割と

もいいます。

– インターフェイスおよびドメイン ID：ドメイン ID によって識別されたスイッチのインター

フェイスを指定します。

– ドメイン ID およびポート番号：MDS ドメインのドメイン ID を指定し、他社製スイッチに属

するポートを追加指定します。
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– IPv4 アドレス：接続されたデバイスの IPv4 アドレス（およびオプションでサブネット マス

ク）を指定します。

– IPv6 アドレス：接続された複数のデバイスをコロンで区切った 16 進表記の 128 ビットの 
IPv6 アドレス。

• デフォルト ゾーン メンバシップには、特定のメンバシップとの関係を持たないすべてのポートま

たは WWN が含まれます。デフォルト ゾーン メンバー間のアクセスは、デフォルト ゾーン ポリ

シーによって制御されます。

• VSAN あたり最大 8000 ゾーン、さらにスイッチ上のすべての VSAN 合計で最大 8000 までのゾー

ンを設定できます。

ゾーン分割の例

図 5-1 に、ファブリックの 2 つのゾーン（ゾーン 1 およびゾーン 2）で構成されるゾーン セットを示し

ます。ゾーン 1 は、3 つすべてのホスト（H1、H2、H3）からストレージ システム S1 と S2 に常駐す

るデータへのアクセスを提供します。ゾーン 2 は、S3 のデータを H3 からのアクセスだけに限定しま

す。H3 は両方のゾーンに存在することに注意してください。

図 5-1 2 つのゾーンを持つファブリック 

もちろん、このファブリックをゾーンに分割する方法は他にもあります。図 5-2 に、その他の方法を示

します。新しいソフトウェアをテストする目的で、ストレージ システム S2 を分離する必要があると想

定します。これを実行するために、ホスト H2 とストレージ S2 だけを含むゾーン 3 が設定されます。

ゾーン 3 ではアクセスを H2 と S2 だけに限定し、ゾーン 1 ではアクセスを H1 と S1 だけに限定できま

す。
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図 5-2 3 つのゾーンを持つファブリック 

ゾーン実装

Cisco MDS 9000 ファミリのすべてのスイッチは、以下の基本ゾーン機能を自動的にサポートします

（追加の設定は不要です）。

• ゾーンが VSAN（仮想 SAN）に含まれます。

• ハード ゾーン分割は、ディセーブルにできません。

• ネーム サーバ クエリがソフト ゾーン分割されます。

• アクティブ ゾーン セットだけが配信されます。

• ゾーンが分割できないデバイスは、相互にアクセスできません。

• 各 VSAN に同一名のゾーンまたはゾーン セットを含めることができます。

• 各 VSAN は、フル データベースとアクティブ データベースを持ちます。

• アクティブ ゾーン セットを変更するには、フル ゾーン データベースをアクティブ化する必要があ

ります。

• アクティブ ゾーン セットは、スイッチを再起動しても維持されます。

• フル データベースへの変更は、明示的に保存する必要があります。

• ゾーンの再アクティブ化（ゾーン セットがアクティブの状態で、別のゾーン セットをアクティブ

化する場合）は、既存のトラフィックに干渉しません。

必要に応じて、さらに次のゾーン機能を設定できます。

• VSAN 単位ですべてのスイッチにフル ゾーン セットを伝播します。

• ゾーンに属さないメンバーのデフォルト ポリシーを変更します。

• VSAN を interop モードに設定して、他のベンダーと相互運用します。相互に干渉することなく、

同じスイッチ内の 1 つの VSAN を interop モードに、別の VSAN を基本モードに設定することも

できます。

• E ポートの分離を解除します。
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ゾーン メンバー設定に関する注意事項

ゾーンのすべてのメンバーは互いに通信できます。メンバー数が N のゾーンの場合、N*(N-1) のアク

セス権限をイネーブルにする必要があります。単一ゾーン内にターゲットまたは発信元を多数設定しな

いことを推奨します。多数設定してしまうと、実際には互いに通信することのない通信ペア（発信側と

発信側間、ターゲットとターゲット間）の多くがプロビジョニング /管理の対象となるため、スイッチ 
リソースの浪費になります。この理由から、1 つの発信側に対して 1 つのターゲットを設定するのが最

も効率的なゾーン分割方法といえます。

ゾーン メンバーを作成するときは、以下の注意事項について検討する必要があります。

• ゾーンに対して 1 つの発信側と 1 つのターゲットだけ設定すると、スイッチ リソースの使用率が

最も効率的になります。

• 複数のターゲットに同じ発信側を設定することは許容されます。

• 複数のターゲットに複数の発信側を設定することは推奨されません。

アクティブおよびフル ゾーン セットに関する考慮事項

ゾーン セットを設定する前に、次の注意事項について検討してください。

• 各 VSAN は、複数のゾーン セットを持つことができますが、アクティブにできるのは常に 1 つの

ゾーン セットだけです。

• ゾーン セットを作成すると、そのゾーン セットは、フル ゾーン セットの一部となります。

• ゾーン セットがアクティブな場合は、フル ゾーン セットのゾーン セットのコピーがゾーン分割に

使用されます。これは、アクティブ ゾーン セットと呼ばれます。アクティブ ゾーン セットは変更

できません。アクティブ ゾーン セットに含まれるゾーンは、アクティブ ゾーンと呼ばれます。

• 管理者は、同一名のゾーン セットがアクティブである場合も、フル ゾーン セットを変更すること

ができます。ただし、再起動するまで変更は反映されません。

• アクティブ化が実行されると、永続的なコンフィギュレーションにアクティブ ゾーン セットが自

動保存されます。これにより、スイッチのリセットにおいてもスイッチはアクティブ ゾーン セッ

ト情報を維持できます。

• ファブリックのその他すべてのスイッチがアクティブ ゾーン セットを受信するので、それぞれの

スイッチでゾーン分割を実行できます。

• ハードおよびソフト ゾーン分割は、アクティブ ゾーン セットを使用して実装されます。変更は、

ゾーン セットのアクティブ化の際に行われます。

• アクティブ ゾーン セットに含まれない FC ID または Nx ポートは、デフォルト ゾーンに所属し、

デフォルト ゾーン情報は、他のスイッチに配信されません。

（注） 1 つのゾーン セットがアクティブな場合に、別のゾーン セットをアクティブにすると、現在アクティ

ブなゾーン セットが自動的に非アクティブになります。新しいゾーン セットをアクティブにする前に、

現在のアクティブ ゾーン セットを明示的に非アクティブにする必要はありません。

図 5-3に、アクティブ化されたゾーン セットに追加されるゾーンを示します。
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図 5-3 アクティブおよびフル ゾーン セット
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Quick Config ウィザードの使用

（注） Quick Config ウィザードは、スイッチ インターフェイス ゾーン メンバーだけをサポートします。

Cisco SAN-OS Release 3.1(1) および NX-OS Release 4.1(2) 以降では、Cisco MDS 9124 スイッチの 
Quick Config ウィザードを使用して VSAN ごとにゾーン メンバーの追加または削除を行えます。

Quick Config ウィザードを使用してインターフェイスベースのゾーン分割を実行し、Device Manager 
を使用して複数の VSAN にゾーン メンバーを割り当てることができます。

（注） Quick Config ウィザードは、Cisco MDS 9124 Fabric Switch、Cisco MDS 9134 Fabric Switch、Cisco 
Fabric Switch for HP c-Class BladeSystem、および Cisco Fabric Switch for IBM BladeCenter でサポー

トされます。

注意 Quick Config ウィザードは、スイッチで既存のゾーン分割が定義されていないスタンドアロン ス
イッチでだけ使用できます。

Cisco MDS 9124 スイッチで Device Manager を使用して、ゾーンにポートを追加またはゾーンから

ポートを削除し、特定の VSAN 内のデバイスだけをゾーン分割する手順は、次のとおりです。

ステップ 1 [FC] > [Quick Config] を選択するか、ツールバーの Zone アイコンをクリックします。

すべてのコントロールがディセーブルになっている Quick Config ウィザード（図 5-5 を参照）および

すべてのサポートされていない設定を表示する [Discrepancies] ダイアログボックス（図 5-4 を参照）

が表示されます。

（注） [Discrepancies] ダイアログボックスは、矛盾がある場合だけ表示されます。
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図 5-4 [Discrepancies] ダイアログボックス

ステップ 2 [OK] をクリックして続行します。

図 5-5 に示す [Quick Config Wizard] ダイアログボックスが表示されます。

注意 矛盾がある場合、[OK] をクリックすると、ゾーン データベース内の VSAN のうち、影響を

受けた VSAN がクリアされます。このため、スイッチが使用中の間、中断が生じることが

あります。
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図 5-5 Quick Config ウィザード

ステップ 3 ゾーンに追加する、またはゾーンから削除するポートの [Ports Zoned To] 列のチェックボックスをオン

にします。一致するポートのチェックボックスが同様に設定されます。選択されたポート ペアがゾー

ンに追加またはゾーンから削除され、2 デバイス ゾーンが作成されます。

[VSAN] ドロップダウン メニューには、選択された VSAN 内のデバイスだけをゾーン分割できるフィ

ルタが用意されています。

ステップ 4 列の表示と非表示を切り替えるには、列の名前を右クリックします。

ステップ 5 [Next] をクリックして変更を確認します。

図 5-6 に示す [Confirm Changes] ダイアログボックスが表示されます。
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図 5-6 [Confirm Changes] ダイアログボックス

ステップ 6 CLI コマンドを確認する場合は、ダイアログボックスを右クリックし、ポップアップ メニューから 
[CLI Commands] をクリックします。

ステップ 7 [Finish] をクリックして設定変更を保存します。
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ゾーン設定
ここではゾーンの設定方法について、次の内容を説明します。

• 「Edit Local Full Zone Database ツールの概要」（P.5-11）

• 「Zone Configuration Tool を使用したゾーンの設定」（P.5-12）

• 「ゾーン メンバーの追加」（P.5-14）

Edit Local Full Zone Database ツールの概要

Edit Local Full Zone Database ツールを使用すると、複数のスイッチでゾーン分割ができ、[Edit Local 
Full Zone Database] ダイアログボックスですべてのゾーン分割機能が使用可能になります（図 5-7 を
参照）。

図 5-7 [Edit Local Full Zone Database] ダイアログボックス

1 ダイアログボックスを閉じずに、ドロップダ

ウン メニューで VSAN を選択して再入力す

ると、VSAN 別の情報を表示できます。

3 複数のフォルダ内のエイリアスに基づいて

ゾーン分割特性を追加できます。

2 [Add to zone] ボタンを使用すると、エイリア

スまたはゾーン単位でデバイスを上下に移動

できます。

4 ツリー内のゾーン セット、ゾーン、またはエ

イリアスの名前を変更するには、トリプルク

リックします。
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（注） [Device Alias] ラジオ ボタンは、デバイスのエイリアスが enhanced モードのときにだけ表示されます。

詳細については、「デバイス エイリアスの作成」（P.6-7）を参照してください。

ヒント [Physical Attributes] ペインから [Switches] を展開して sWWN を取得します。sWWN を指定しない場

合は、自動的にローカル sWWN が使用されます。

（注） インターフェイスベース ゾーン分割は、Cisco MDS 9000 ファミリ スイッチでだけ機能します。イン

ターフェイスベースゾーン分割は、その VSAN で interop モードが設定されている場合は動作しませ

ん。

Zone Configuration Tool を使用したゾーンの設定

Fabric Manager を使用してゾーンを作成し、これをゾーン セットに移動する手順は、次のとおりです。

ステップ 1 ツールバーにある [Zone] アイコンをクリックします（図 5-8 を参照）。

図 5-8 [Zone] アイコン

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 ゾーンを作成する VSAN を選択し、[OK] をクリックします。

図 5-9 に示す [Edit Local Full Zone Database] ダイアログボックスが表示されます。
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図 5-9 [Edit Local Full Zone Database] ダイアログボックス

ゾーン メンバシップ情報を表示する場合は、[All Zone Membership(s)] 列を右クリックして、ポップ

アップ メニューで現在の行またはすべての行の [Show Details] をクリックします。

ステップ 3 左側のペインの [Zones] をクリックし、[Insert] アイコンをクリックして、ゾーンを作成します。

[Create Zone] ダイアログボックスが表示されます（図 5-10 を参照してください）。

図 5-10 [Create Zone] ダイアログボックス

ステップ 4 ゾーン名を入力します。

ステップ 5 次のチェックボックスのうち 1 つをオンにします。

a. Read Only:このゾーンでは読み込みを許可し、書き込みは拒否します。

b. Permit QoS traffic with Priority:ドロップダウン メニューでプライオリティを設定します。

c. Restrict Broadcast frames to Zone Members（ブロードキャスト フレームをゾーン メンバーに制

限）

ステップ 6 [OK] をクリックしてゾーンを作成します。

このゾーンを既存のゾーン セットに移動する場合は、ステップ 8 へスキップします。

ステップ 7 左側のペインの [Zoneset] をクリックし、[Insert] アイコンをクリックして、ゾーン セットを作成しま

す
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[Zoneset Name] ダイアログボックスが表示されます（図 5-11 を参照）。

図 5-11 [Zoneset Name] ダイアログボックス

ステップ 8 ゾーン セット名を入力し、[OK] をクリックします。

（注） シンボル（$、-、^、_）のうちの 1 つまたはすべての英数字がサポートされています。interop 
モード 2 と 3 では、シンボル（_）またはすべての英数字がサポートされています。

ステップ 9 ゾーンを追加するゾーン セットを選択して [Insert] アイコンをクリックするか、[Zoneset1] へ Zone3 
をドラッグ アンド ドロップします。

[Select Zone] ダイアログボックスが表示されます（図 5-12 を参照）。

図 5-12 [Select Zone] ダイアログボックス

ステップ 10 [Add] をクリックして、ゾーンを追加します。

ゾーン メンバーの追加

ゾーンを作成すると、ゾーンにメンバーを追加できます。メンバーを追加するには、複数のポート識別

タイプを使用します。

Fabric Manager を使用してゾーンにメンバーを追加する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。
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図 5-13 [Edit Local Full Zone Database] ダイアログボックス

ステップ 3 [Fabric] ペイン（図 5-13 を参照）から追加するメンバーを選択し、[Add to Zone] をクリックするか、

メンバーを追加するゾーンをクリックし、[Insert] アイコンをクリックします。

図 5-14 に示す [Add Member to Zone] ダイアログボックスが表示されます。

図 5-14 [Add Member to Zone] ダイアログボックス

（注） [Device Alias] ラジオ ボタンは、デバイスのエイリアスが enhanced モードのときにだけ表示さ

れます。詳細については、「デバイス エイリアスの作成」（P.6-7）を参照してください。

ステップ 4 参照ボタンをクリックしてポート名を選択するか、[LUN] チェックボックスをクリックしてから参照

ボタンをクリックして LUN を設定します。
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ステップ 5 [Add] をクリックして、ゾーンにメンバーを追加します。

（注） ゾーン メンバーを設定する場合は、OS ごとに異なる複数の ID が 1 つの Logical Unit Number
（LUN）に設定されるように指定することができます。6 つの異なる OS から選択できます。

名前、WWN、または FC ID に基づくエンド デバイスのフィルタリング

エンド デバイスおよびデバイス エイリアスをフィルタする手順は、次のとおりです。

ステップ 1 ツールバーにある [Zone] アイコンをクリックします（図 5-8 を参照）。

ステップ 2 [With] ドロップダウン リストから名前、[WWN]、または [FC ID] を選択します。

ステップ 3 [Filter] テキストボックスに *zo1* などのフィルタ条件を入力します。

ステップ 4 [Go] をクリックします。

複数のゾーンへの複数のエンド デバイスの追加

複数のゾーンに複数のエンド デバイスを追加する手順は、次のとおりです。

ステップ 1 ツールバーにある [Zone] アイコンをクリックします（図 5-8 を参照）。

ステップ 2 Ctrl キーを使用して複数のエンド デバイスを選択します。

ステップ 3 右クリックし、[Add to Zone] を選択します。

ステップ 4 表示されるポップアップ ウィンドウから、Ctrl キーを使用して複数のゾーンを選択します。

ステップ 5 [Add] をクリックします。

選択されたエンド デバイスが選択されたゾーンに追加されます。

ゾーン セット
ゾーンではアクセス制御を指定するメカニズムが提供されています。それに対して、ファブリック内で

のアクセス制御の実行を補強するためにゾーンをグループ化したものが、ゾーン セットです。

ここではゾーン セットについて、次の内容を説明します。

• 「ゾーン セットの作成の概要」（P.5-17）

• 「ゾーン セットのアクティブ化」（P.5-18）

• 「ゾーン メンバシップ情報の表示」（P.5-21）

• 「デフォルト ゾーンの概要」（P.5-21）

• 「デフォルト ゾーンの設定」（P.5-22）
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• 「FC エイリアスの作成の概要」（P.5-22）

• 「FC エイリアスの作成」（P.5-23）

• 「エイリアスへのメンバーの追加」（P.5-24）

• 「ゾーンメンバーの pWWN ベースメンバーへの変換」（P.5-25）

• 「ゾーン分割の実行」（P.5-28）

ゾーン セットの作成の概要

図 5-15 では、それぞれ独自のメンバシップ階層とゾーン メンバーを持つ別個の 2 つのセットが作成さ

れています。

図 5-15 ゾーン セット、ゾーン、ゾーン メンバーの階層 

ゾーン セット A またはゾーン セット B のいずれか（両方でなく）をアクティブにすることができま

す。

ヒント （ゾーン セットが設定済みの VSAN にある場合）ゾーン セットはメンバー ゾーンと VSAN の名前で設

定されます。

 3
H2 S2

 2
H3 S2

 1
H1 H3 S1

  A   B
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ゾーン セットのアクティブ化

ゾーン セットをアクティブにするまで、ゾーン セットへの変更はフル ゾーン セットで有効になりませ

ん。

Fabric Manager を使用して既存のゾーンをアクティブにする手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 [Activate] をクリックして、ゾーン セットをアクティブにします。

[Pre-Activation Check] ダイアログボックスが表示されます（図 5-16 を参照）。

図 5-16 [Pre-Activation Check] ダイアログボックス

ステップ 4 [Yes] をクリックして、相違を確認します。

[Local vs.Active Differences] ダイアログボックスが表示されます（図 5-17 を参照）。

図 5-17 [Local vs. Active Differences] ダイアログボックス

ステップ 5 [Close] をクリックして、ダイアログボックスを閉じます。

[Save Configuration] ダイアログボックスが表示されます（図 5-18 を参照）。
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図 5-18 [Save Configuration] ダイアログボックス

ステップ 6 すべての変更をスタートアップ コンフィギュレーションに保存するには、[Save Running to Startup 
Configuration] チェックボックスをオンにします。

ステップ 7 ゾーン セットをアクティブにするには [Continue Activation] をクリックします。ダイアログボックス

を閉じて、保存されていない変更を破棄するには、[Cancel] をクリックします。

ゾーン セットのアクティブ化に成功したかどうかを示す [Zone Log] ダイアログボックスが表示されま

す（図 5-19 を参照）。

図 5-19 [Zone Log] ダイアログボックス
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ゾーンセットの非アクティブ化 
既存のゾーンを非アクティブ化する手順は、次のとおりです。

ステップ 1 非アクティブにするゾーン セットを右クリックし、ポップアップ メニューで [Deactivate] をクリック

します。

[Deactivate Zoneset] ダイアログボックスが表示されます（図 5-20 を参照）。

図 5-20  [Deactivate Zoneset] ダイアログボックス

ステップ 2 テキストボックスに deactivate と入力し、[OK] をクリックします。

[Input] ダイアログボックスが表示されます（図 5-21 を参照）。

図 5-21 [Input] ダイアログボックス

ステップ 3 テキストボックスに deactivate と入力し、[OK] をクリックしてゾーン セットを非アクティブにしま

す。

（注） このオプションをイネーブルにするには、server.properties ファイルを修正する必要があります。

server.properties ファイルの修正の詳細については、『Cisco Fabric Manager Fundamentals 
Configuration Guide』を参照してください。
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ゾーン メンバシップ情報の表示

Fabric Manager を使用してゾーンに割り当てられたメンバーのゾーン メンバシップ情報を表示する手

順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 左側のペインで、[Zones] をクリックします。右側のペインに各ゾーンのメンバーが表示されます。

（注） デフォルト ゾーン メンバーは、デフォルト ゾーン ポリシーが permit に設定されている場合

に限り、明示的に表示されます。デフォルト ゾーン ポリシーが deny に設定されている場合、

このゾーンのメンバーは表示されません。「ゾーン情報の表示」（P.5-48）を参照してください。

デフォルト ゾーンの概要

ファブリック（Nx ポートに接続されているデバイス）の各メンバーは、任意のゾーンに所属すること

ができます。どのアクティブ ゾーンにも所属しないメンバーは、デフォルト ゾーンの一部と見なされ

ます。したがって、ファブリックにアクティブなゾーン セットがない場合、すべてのデバイスがデ

フォルト ゾーンに所属すると見なされます。メンバーは複数のゾーンに所属できますが、デフォルト 
ゾーンに含まれるメンバーは、その他のゾーンに所属できません。接続されたポートが起動すると、ス

イッチはポートがデフォルト ゾーンのメンバーかを判別します。

（注） 設定されたゾーンとは異なり、デフォルト ゾーン情報は、ファブリックの他のスイッチに配信されま

せん。

トラフィックをデフォルト ゾーンのメンバー間で許可または拒否できます。この情報は、すべてのス

イッチに配信されません。各スイッチで設定する必要があります。

（注） スイッチが初めて初期化される場合、ゾーンは設定されておらず、すべてのメンバーがデフォルト 
ゾーンに所属すると見なされます。メンバー同士で相互に通信することは許可されていません。

ファブリックの各スイッチにデフォルト ゾーン ポリシーを設定します。ファブリックの 1 つのスイッ

チでデフォルト ゾーン ポリシーを変更する場合、必ずファブリックの他のすべてのスイッチでも変更

してください。

（注） デフォルト ゾーン設定のデフォルト設定を変更できます。

デフォルト ポリシーが permit として設定されている場合、またはゾーン セットがアクティブの場合、

デフォルト ゾーン メンバーが明示的に表示されます。デフォルト ポリシーが deny として設定されて

いる場合は、アクティブなゾーン セットを表示しても、このゾーンのメンバーは明示的に一覧表示さ

れません。
5-21
Cisco Fabric Manager Fabric コンフィギュレーション ガイド

OL-19448-01-J、Cisco MDS NX-OS Release 4.2(x)



第 5 章      ゾーンの設定と管理

ゾーン セット
任意の VSAN のデフォルト ゾーン ポリシーを変更するには、Fabric Manager メニューで [VSANxx] > 
[Default Zone] を選択し、[Policies] タブをクリックします。デバイス間の接続を確立する場合は、こ

れらのデバイスをデフォルト以外のゾーンに割り当てることを推奨します。

デフォルト ゾーンの設定

Fabric Manager を使用してデフォルト ゾーン内のメンバーに対するトラフィックを許可または拒否す

る手順は、次のとおりです。

ステップ 1 VSAN を開き、[Fabric Manager Logical Domains] ペインで [Default Zone] を選択します。

ステップ 2 [Information] ペインで [Policies] タブをクリックします。

[Information] ペインにゾーン ポリシー情報が表示されます（図 5-22を参照）。

図 5-22 デフォルト ゾーン ポリシー

アクティブ ゾーン セットはイタリック体で表示されます。アクティブ ゾーン セットを変更してから変

更をアクティブ化するまでの間は、このゾーン セットが太字のイタリック体で表示されます。

ステップ 3 [Default Zone Behaviour] フィールドで、ドロップダウン メニューから [permit] または [deny] を選択

します。

FC エイリアスの作成の概要

次の値を使用して、エイリアス名を割り当て、エイリアス メンバーを設定できます。

• pWWN：N または NL ポートの WWN は、16 進形式です（10:00:00:23:45:67:89:ab など）。

• fWWN：ファブリック ポート名の WWN は 16 進形式です（10:00:00:23:45:67:89:ab など）。

• FC ID：N ポート ID は、0xhhhhhh 形式です（0xce00d1 など）。

• ドメイン ID：ドメイン ID は 1 ～ 239 の整数です。このメンバシップ設定を完了するには、他社製

スイッチの必須ポート番号が必要です。

• IPv4 アドレス：接続されたデバイスの IPv4 アドレスは、ドット付きの 10 進表記の 32 ビットで、

オプションでサブネット マスクを伴います。マスクが指定されている場合、サブネット内のすべ

てのデバイスが指定されたゾーンのメンバーになります。

• IPv6 アドレス：接続されたデバイスの IPv6 アドレスは、コロン（:）で区切られた 16 進表記の 
128 ビットです。
5-22
Cisco Fabric Manager Fabric コンフィギュレーション ガイド

OL-19448-01-J、Cisco MDS NX-OS Release 4.2(x)



第 5 章      ゾーンの設定と管理

ゾーン セット
• インターフェイス：インターフェイスベースのゾーン分割ではポートベース ゾーン分割と同様に、

ゾーン設定にスイッチ インターフェイスが使用されます。ローカルおよびリモート スイッチの両

方で、スイッチ インターフェイスをゾーン メンバーとして指定できます。リモート スイッチを指

定するには、特定の VSAN 内のリモート sWWN またはドメイン ID を入力します。

ヒント Cisco NX-OS ソフトウェアは、VSAN ごとに最大 2048 個のエイリアスをサポートしています。

FC エイリアスの作成

Fabric Manager を使用して FC エイリアスを作成する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 左下のペインで、[Aliases] をクリックします（図 5-23 を参照）。右側のペインに既存のエイリアスが

表示されます。

図 5-23 FC エイリアスの作成

ステップ 4 [Insert] アイコンをクリックして、エイリアスを作成します。

[Create Alias] ダイアログボックスが表示されます（図 5-24 を参照）。

図 5-24 [Create Alias] ダイアログボックス
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ステップ 5 エイリアス名および pWWN を設定します。

ステップ 6 [OK] をクリックしてエイリアスを作成します。

エイリアスへのメンバーの追加

Fabric Manager を使用してエイリアスにメンバーを追加する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます（図 5-25 を参

照）。

図 5-25 [Edit Local Full Zone Database] ダイアログボックス

ステップ 3 [Fabric] ペインから追加するメンバーを選択し（図 5-25 を参照）、[Add to Alias] をクリックするか、

メンバーを追加するエイリアスをクリックし、[Insert] アイコンをクリックします。

図 5-26 に示す [Add Member to Alias] ダイアログボックスが表示されます。
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図 5-26 [Add Member to Alias] ダイアログボックス 

（注） [Device Alias] ラジオ ボタンは、デバイスのエイリアスが enhanced モードのときにだけ表示さ

れます。詳細については、「デバイス エイリアスの作成」（P.6-7）を参照してください。

ステップ 4 参照ボタンをクリックしてポート名を選択するか、[LUN] チェックボックスをクリックしてから参照

ボタンをクリックして LUN を設定します。

ステップ 5 [Add] をクリックして、エイリアスにメンバーを追加します。

ゾーンメンバーの pWWN ベースメンバーへの変換

ゾーンおよびエイリアス メンバーをスイッチ ポートまたは FC ID ベースのメンバシップから pWWN 
ベースのメンバシップに変換できます。この機能を利用して、pWWN へ変換すれば、カードまたはス

イッチがファブリックで変更されてもゾーン設定は変更されません。

Fabric Manager を使用してスイッチ ポートと FC ID メンバーを pWWN メンバーに変換する手順は、

次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 変換するゾーンをクリックします。

ステップ 4 [Tools] > [Convert Switch Port/FCID members to By pWWN] を選択します。

変換するすべてのメンバーが列挙された [Conversion] ダイアログボックスが表示されます。

ステップ 5 変更を確認し、[Continue Conversion] をクリックします。
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ステップ 6 確認ダイアログボックスで [Yes] をクリックして、そのメンバーを pWWN ベースのメンバシップに変

更します。

（注） 1 つのゾーン セットがアクティブな場合に、別のゾーン セットをアクティブにすると、現在ア

クティブなゾーン セットが自動的に非アクティブになります。

ヒント 実行コンフィギュレーションをスタートアップ コンフィギュレーションにコピーしてアクティブ ゾー

ン セットを保存する必要はありません。ただし、明示的にフル ゾーン セットを保存するには、実行コ

ンフィギュレーションをスタートアップ コンフィギュレーションにコピーする必要があります。ス

イッチのリセット時には使用できません。

注意 IVR に対しても設定されている VSAN 内のアクティブ ゾーン セットを非アクティブにした場合、

アクティブ IVR ゾーン セット（IVZS）も非アクティブになり、スイッチとの間のすべての IVR ト
ラフィックは停止されます。この非アクティブ化により、複数の VSAN でトラフィックが中断され

る場合があります。アクティブ ゾーン セットを非アクティブにする前に、VSAN のアクティブ 
ゾーン分析をチェックしてください。IVZS を再度アクティブ化するには、標準ゾーン セットを再

度アクティブ化する必要があります（『Cisco MDS 9000 Family NX-OS Inter-VSAN Routing 
Configuration Guide』を参照）。

注意 現在アクティブなゾーン セットに IVR ゾーンが含まれている場合、IVR がイネーブルになってい

ないスイッチからゾーン セットをアクティブにすると、その VSAN との間の IVR トラフィックが

中断されます。常に IVR 対応のスイッチからゾーン セットをアクティブにして、IVR トラフィッ

クの中断を回避することを強くお勧めします。

（注） 仮想ターゲットの pWWN は、Fabric Manager のゾーン分割エンド デバイスのデータベースには表示

されません。pWWN で仮想デバイスのゾーン分割を行う場合は、ゾーンを作成するときにこれを 
[Add Member to Zone] ダイアログボックスに入力する必要があります。ただし、デバイス エイリアス

が拡張モードの場合、仮想デバイス名は Fabric Manager の [Zoning] ウィンドウの [Device Alias 
Database] に表示されます。この場合、デバイス エイリアス名を選択するか、[Add Member to Zone] 
ダイアログボックスで pWWN を入力することができます。

詳細については、「ゾーン メンバーの追加」（P.5-14）を参照してください。
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（注） SDV を使用する場合はデバイス エイリアス モードを enhanced に設定します（仮想デバイスの 
pWWN が変化する可能性があるため）。

たとえば、SDV がスイッチでイネーブルになっていて、仮想デバイスが定義されているとします。

SDV は仮想デバイスの pWWN を割り当て、ゾーン内の pWWN に基づいてゾーン分割されます。後で 
SDV をディセーブルにした場合、この設定は失われます。SDV を再度イネーブルにし、同じ名前を使

用して仮想デバイスを作成する場合、同じ pWWN が再び取得される保証はありません。このため、

pWWN ベースのゾーンを再度ゾーン分割する必要があります。ただし、デバイス /エイリアス名に基

づくゾーン分割を実行する場合は、pWWN の変更時に設定変更は必要ありません。

デバイス エイリアス モードをイネーブルにする前に、デバイス エイリアス モードがどのように動作す

るのかを確認してください。デバイス エイリアス モードの詳細と要件については、第 6 章「デバイス 
エイリアス サービスの配信」を参照してください。

名前に基づくゾーン、ゾーン セット、およびデバイス エイリアスのフィル
タリング

ゾーン、ゾーン セット、またはデバイス エイリアスをフィルタする手順は、次のとおりです。

ステップ 1 ツールバーにある [Zone] アイコンをクリックします（図 5-8 を参照）。

ステップ 2 [Filter] テキストボックスに *zo1* などのフィルタ条件を入力します。

ステップ 3 [Go] をクリックします。

複数のゾーン セットへの複数のゾーンの追加

複数のゾーン セットに複数のゾーンを追加する手順は、次のとおりです。

ステップ 1 ツールバーにある [Zone] アイコンをクリックします（図 5-8 を参照）。

ステップ 2 ツリー表示から、[Zoneset] を選択します。

ステップ 3 Ctrl キーを使用して複数のゾーンを選択します。

ステップ 4 右クリックし、[Add to Zoneset] を選択します。

ステップ 5 表示されたポップアップ ウィンドウから、Ctrl キーを使用して複数のゾーン セットを選択します。

ステップ 6 [Add] をクリックします。

選択されたゾーンが、選択されたゾーン セットに追加されます。
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ゾーン分割の実行

ゾーン分割を実行するには、ソフトおよびハードの 2 とおりの方法があります。各エンド デバイス（N 
ポートまたは NL ポート）は、ネーム サーバにクエリを送信することでファブリックの他のデバイス

を検出します。デバイスがネーム サーバにログインすると、ネーム サーバはクエリ元デバイスがアク

セスできるその他のデバイスのリストを返します。Nx ポートがゾーンの外部にあるその他のデバイス

の FC ID を認識しない場合、そのデバイスにアクセスできません。

ソフトゾーン分割では、ゾーン分割制限がネーム サーバとエンド デバイス間の対話時にだけ適用され

ます。エンド デバイスが何らかの方法でゾーン外部のデバイスの FC ID を認識できる場合、そのデバ

イスにアクセスできます。

ハード ゾーン分割は、Nx ポートから送信される各フレームでハードウェアによって実行されます。ス

イッチにフレームが着信した時点で、発信元 /宛先 ID と許可済みの組み合わせが照合されるため、ワ

イヤ スピードでフレームを送信できます。ハード ゾーン分割は、ゾーン分割のすべての形式に適用さ

れます。

（注） ハード ゾーン分割は、すべてのフレームでゾーン分割制限を実行し、不正なアクセスを防ぎます。

Cisco MDS 9000 ファミリのスイッチは、ハードおよびソフトの両方のゾーン分割をサポートしていま

す。

ゾーン セット配信
フル ゾーン セットを配信するには、ワンタイム配信またはフル ゾーン セット配信のいずれかの方法を

使用します。表 5-1 に、これらの配信方法の相違を示します。

ここではゾーン セット配信について、次の内容を説明します。

• 「フル ゾーン セット配信のイネーブル化」（P.5-29）

• 「ワンタイム配信のイネーブル化」（P.5-29）

• 「リンクの分離からの回復の概要」（P.5-30）

• 「ゾーン セットのインポートおよびエクスポート」（P.5-31）

表 5-1 ゾーン セット配信の相違

ワンタイム配信 フル ゾーン セット配信

ただちにフル ゾーン セットを配信します。 すぐにはフル ゾーン セットを配信しません。

アクティブ化、非アクティブ化、またはマージ プ
ロセス中は、アクティブなゾーン セットとともに

フル ゾーン セット情報を配信しません。

アクティブ化、非アクティブ化、またはマージ プ
ロセス中にアクティブなゾーン セットとともにフ

ル ゾーン セット情報を配信することを記憶して

います。
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フル ゾーン セット配信のイネーブル化

Cisco MDS 9000 ファミリのすべてのスイッチは、新しい E ポート リンクが立ち上がったとき、または

新しいゾーン セットが VSAN でアクティブ化されたときに、アクティブ ゾーン セットを配信します。

ゾーン セットの配信は、隣接スイッチへのマージ要求の送信時、またはゾーン セットのアクティブ化

の際に行われます。

Fabric Manager を使用して VSAN ベースですべてのスイッチへのフル ゾーン セットおよびアクティブ 
ゾーン セットの配信をイネーブルにする手順は、次のとおりです。

ステップ 1 VSAN を開き、[Logical Domains] ペインで、ゾーン セットを選択します。

[Information] ペインにゾーン セットの設定が表示されます。[Active Zones] タブはデフォルトです。

ステップ 2 [Policies] タブをクリックします。

ゾーンの設定されたポリシーが表示されます（図 5-27 を参照）。

図 5-27 ゾーンに設定されたポリシー

ステップ 3 [Propagation] 列で、ドロップダウン メニューから fullZoneset を選択します。

ステップ 4 [Apply Changes] をクリックして、フル ゾーン セットを伝播します。

ワンタイム配信のイネーブル化

ファブリック全体で、非アクティブ、非変更のゾーン セットのワンタイム配信が行えます。Fabric 
Manager からフル ゾーン セットのワンタイム配信を伝播する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 2 左側のペインでリストから適切なゾーンをクリックします。

ステップ 3 [Distribute] ボタンをクリックして、ファブリック内でフル ゾーン セットを配信します。
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この手順では、フル ゾーン セット情報が配信されるだけです。情報はスタートアップ コンフィギュ

レーションには保存されません。フル ゾーン セット情報をスタートアップ コンフィギュレーションに

保存するには、実行コンフィギュレーションをスタートアップ コンフィギュレーションに明示的に保

存する必要があります。

（注） フル ゾーン セットのワンタイム配信は、interop 2 および interop 3 モードでサポートされていますが、

interop 1 モードではサポートされていません。

リンクの分離からの回復の概要 
ファブリックの 2 つのスイッチが TE ポートまたは E ポートを使用して結合される場合、アクティブ 
ゾーン セットのデータベースが 2 つのスイッチまたはファブリック間で異なると、この TE ポートおよ

び E ポートが分離することがあります。TE ポートまたは E ポートが分離した場合、次の 3 つのオプ

ションのいずれかを使用して分離状態からポートを回復できます。

• 近接スイッチのアクティブ ゾーン セットのデータベースをインポートし、現在のアクティブ ゾー

ン セットと交換します（図 5-28 を参照）。

• 現在のデータベースを隣接のスイッチにエクスポートします。

• フル ゾーン セットを編集し、修正されたゾーン セットをアクティブにしてから、リンクを立ち上

げることにより手動で矛盾を解決します。

図 5-28 データベースのインポートとエクスポート 
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ゾーン セットのインポートおよびエクスポート

Fabric Manager を使用してゾーン セット情報を近接スイッチとの間でインポートまたはエクスポート

する手順は、次のとおりです。

ステップ 1 [Tools] > [Zone Merge Fail Recovery] を選択します。

図 5-29 に示す [Zone Merge Failure Recovery] ダイアログボックスが表示されます。

図 5-29 [Zone Merge Failure Recovery] ダイアログボックス

ステップ 2 [Import Active Zoneset] または [Export Active Zoneset] ラジオ ボタンを選択します。

ステップ 3 ドロップダウン リストで、ゾーン セット情報のインポート元またはエクスポート先になるスイッチを

選択します。

ステップ 4 ドロップダウン リストで、ゾーン セット情報のインポート元またはエクスポート先になる VSAN を選

択します。

ステップ 5 インポート プロセスに使用するインターフェイスを選択します。

ステップ 6 [OK] をクリックして、アクティブ ゾーン セットをインポートまたはエクスポートします。

（注） import および export は、単一のスイッチから発行します。1 つのスイッチからインポートし、別のス

イッチからエクスポートすると、リンクが再び分離する可能性があります。
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コピーを作成し、既存のアクティブ ゾーン セットを変更することなく編集することができます。アク

ティブ ゾーン セットを bootflash: ディレクトリ、volatile: ディレクトリ、または slot0 から次のいずれ

かのエリアにコピーすることができます。

• フル ゾーン セット

• リモート ロケーション（FTP、SCP、SFTP、または TFTP を使用）

アクティブ ゾーン セットは、フル ゾーン セットに含まれません。フル ゾーン セットが失われた場合、

または伝送されなかった場合に、既存のゾーン セットに変更を加え、アクティブにすることはできま

せん。

注意 アクティブ ゾーン セットをフル ゾーン セットにコピーする際に、同一名のゾーンがフル ゾーン 
セット データベースにすでに存在する場合は、上書きされる可能性があります。

ここで説明する内容は、次のとおりです。

• 「ゾーン セットのコピー」（P.5-33）

• 「ゾーンのバックアップおよび復元の概要」（P.5-34）

• 「ゾーンのバックアップ」（P.5-34）

• 「ゾーン、ゾーン セット、およびエイリアスの名前の変更」（P.5-38）

• 「ゾーン、ゾーン セット、FC エイリアス、およびゾーン属性グループのコピー」（P.5-39）

• 「MDS 以外のデータベースの移行」（P.5-39）

• 「ゾーン サーバ データベースのクリア」（P.5-40）
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ゾーン セットのコピー

Cisco MDS ファミリ スイッチでは、アクティブ ゾーン セットを編集できません。ただし、アクティブ 
ゾーン セットをコピーして新しいゾーン セットを作成し、これを編集することはできます。

Fabric Manager を使用してゾーン セットをコピーする手順は、次のとおりです。

ステップ 1 [Zone] > [Copy Full Zone Database] を選択します。

[Copy Full Zone Database] ダイアログボックスが表示されます（図 5-30 を参照）。

図 5-30 [Copy Full Zone Database] ダイアログボックス

ステップ 2 コピーするデータベースのタイプに応じて、[Active] または [Full] ラジオ ボタンをクリックします。

ステップ 3 ドロップダウン リストでコピー元 VSAN を選択します。

ステップ 4 [Copy Full] を選択した場合は、ドロップダウン リストでコピー元スイッチおよびコピー先 VSAN を選

択します。

ステップ 5 ドロップダウン リストでコピー先スイッチを選択します。

ステップ 6 [Copy] をクリックしてデータベースをコピーします。

注意 Inter-VSAN Routing（IVR）機能がイネーブルになっていて、IVR ゾーンがアクティブ ゾーン 
セット内に存在する場合、ゾーン セット コピー操作はすべての IVR ゾーンをフル ゾーン データ

ベースにコピーします。IVR ゾーンへのコピーを防ぐには、コピー操作を実行する前に、フル ゾー

ン セット データベースから明示的に削除する必要があります。IVR 機能の詳細については、

『Cisco MDS 9000 Family NX-OS Inter-VSAN Routing Configuration Guide』を参照してください。
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ゾーンのバックアップおよび復元の概要

ゾーン設定をワークステーションにバックアップするには、TFTP 使用します。このゾーン バックアッ

プ ファイルは、スイッチにゾーン設定を復元する場合に使用できます。ゾーン設定を復元すると、ス

イッチの既存のゾーン設定が上書きされます。

ゾーンのバックアップ

Fabric Manager を使用してフル ゾーン設定をバックアップする手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます（図 5-31 を参

照）。

図 5-31 [Edit Local Full Zone Database] ダイアログボックス

ステップ 3 [File] > [Backup] > [This VSAN Zones] を選択して、TFTP、SFTP、SCP、または FTP を使用して既

存のゾーン設定をワークステーションにバックアップします。

図 5-32 に示す [Backup Zone Configuration] ダイアログボックスが表示されます。
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図 5-32 [Backup Zone Configuration] ダイアログボックス

データをリモート サーバにバックアップする前に、この設定を編集できます。

ステップ 4 次の [Remote Options] 情報を指定して、データをリモート サーバにバックアップします。

a. Using：プロトコルを選択します。

b. Server IP Address：サーバの IP アドレスを入力します。

c. UserName：ユーザの名前を入力します。

d. Password：ユーザのパスワードを入力します。

e. File Name(Root Path)：パスとファイル名を入力します。

ステップ 5 [Backup] をクリックするか、[Cancel] をクリックしてバックアップせずにダイアログボックスを閉じ

ます。

ゾーンの復元

Fabric Manager を使用してゾーン設定を復元する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます（図 5-33 を参

照）。
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図 5-33 [Edit Local Full Zone Database] ダイアログボックス

ステップ 3 [File] > [Restore] を選択して、TFTP、SFTP、SCP、または FTP を使用して保存されたゾーン設定を

復元します。

図 5-34 に示す [Restore Zone Configuration] ダイアログボックスが表示されます。

図 5-34 [Restore Zone Configuration] ダイアログボックス

スイッチにこの設定を復元する前に、設定を編集することもできます。
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ステップ 4 次の [Remote Options] 情報を指定して、データをリモート サーバから復元します。

a. Using：プロトコルを選択します。

b. Server IP Address：サーバの IP アドレスを入力します。

c. UserName：ユーザの名前を入力します。

d. Password：ユーザのパスワードを入力します。

e. File Name：パスとファイル名を入力します。

ステップ 5 [Restore] をクリックして続行するか、[Cancel] をクリックして復元せずにダイアログボックスを閉じ

ます。

（注） [View Config] をクリックして、リモート サーバからゾーン設定ファイルを復元する方法に関する情報

を確認します。このダイアログボックスで [Yes] をクリックすると、実行される CLI コマンドが表示さ

れます。ダイアログボックスを閉じるには、[Close] をクリックします。

（注） [Backup] オプションおよび [Restore] オプションは、Cisco NX-OS Release 4.1(3) 以降を実行するス

イッチで使用できます。
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ゾーン、ゾーン セット、およびエイリアスの名前の変更

Fabric Manager を使用してゾーン、ゾーン セット、またはエイリアスの名前を変更する手順は、次の

とおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます（図 5-35 を参

照）。

図 5-35 [Edit Local Full Zone Database] ダイアログボックス

ステップ 3 左側のペインでゾーンまたはゾーン セットをクリックします。

ステップ 4 [Edit] > [Rename] を選択します。

ゾーンまたはゾーン セット名の周囲にエディット ボックスが表示されます。

ステップ 5 新しい名前を入力します。

ステップ 6 [Activate] または [Distribute] をクリックします。
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ゾーン、ゾーン セット、FC エイリアス、およびゾーン属性グループのコ
ピー

ゾーン、ゾーン セット、FC エイリアス、またはゾーン属性グループをコピーする手順は、次のとおり

です。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 [Edit] > [Clone] を選択します。

[Clone Zoneset] ダイアログボックスが表示されます（図 5-36 を参照）。デフォルトの名前は Clone の
後ろに元の名前が付きます。

図 5-36 [Clone Zoneset] ダイアログボックス

ステップ 4 コピーされたエントリの名前を変更します。

ステップ 5 [OK] をクリックして新しいコピーを保存します。

コピーされたデータベースは、元のデータベースとともに表示されます。

MDS 以外のデータベースの移行

Zone Migration ウィザードを使用して Fabric Manager を使用した MDS 以外のデータベースを移行す

る手順は、次のとおりです。

ステップ 1 [Zone] > [Migrate Non-MDS Database] を選択します。

Zone Migration ウィザードが表示されます。

ステップ 2 ウィザードのプロンプトに従って、データベースを移行します。
5-39
Cisco Fabric Manager Fabric コンフィギュレーション ガイド

OL-19448-01-J、Cisco MDS NX-OS Release 4.2(x)



第 5 章      ゾーンの設定と管理

詳細なゾーン属性
ゾーン サーバ データベースのクリア

指定された VSAN のゾーン サーバ データベース内のすべての設定情報をクリアできます。ゾーン 
サーバ データベースのクリアについては、『Cisco MDS 9000 Family CLI Configuration Guide』を参照

してください。

（注） ゾーン セットをクリアするとフル ゾーン データベースだけが消去され、アクティブ ゾーン データ

ベースは消去されません。

（注） ゾーン サーバ データベースをクリアした後に、明示的に実行コンフィギュレーションをスタートアッ

プ コンフィギュレーションにコピーして、スイッチの再起動時に実行コンフィギュレーションが使用

されるようにする必要があります。

詳細なゾーン属性
ここでは詳細なゾーン属性について、次の内容を説明します。

• 「ゾーンベースのトラフィック プライオリティの概要」（P.5-41）

• 「ゾーンベースのトラフィック プライオリティの設定」（P.5-41）

• 「デフォルト ゾーンの QoS プライオリティ属性の設定」（P.5-42）

• 「デフォルト ゾーン ポリシーの設定」（P.5-43）

• 「ブロードキャスト ゾーン分割の概要」（P.5-44）

• 「ブロードキャスト ゾーン分割の設定」（P.5-44）

• 「LUN ゾーン分割の概要」（P.5-45）

• 「LUN ベースのゾーンの設定」（P.5-46）

• 「ストレージ サブシステムへの LUN の割り当て」（P.5-47）

• 「読み取り専用ゾーンの概要」（P.5-47）

• 「読み取り専用ゾーンの設定」（P.5-48）
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ゾーンベースのトラフィック プライオリティの概要

ゾーン分割機能は、ファブリック内の特定のゾーンのプライオリティを設定し、デバイス間のアクセス

制御を設定するための追加の分離メカニズムを提供します。この機能を使用して、Quality Of Service
（QoS）プライオリティをゾーン属性として設定できます。QoS トラフィックプライオリティを high、
medium、または low に割り当てることができます。デフォルトでは、プライオリティが指定されてい

ないゾーンは暗黙的に low プライオリティを割り当てられます。詳細については、『Cisco MDS 9000 
NX-OS Family Quality of Service Configuration Guide』を参照してください。

この機能を使用するには、ENTERPRISE_PKG ライセンスを取得し（『Cisco NX-OS Family Licensing 
Guide』を参照）、スイッチで QoS をイネーブルにする必要があります（『Cisco MDS 9000 Family 
NX-OS Quality of Service Configuration Guide』を参照）。

この機能により、SAN 管理者は使い慣れたデータ フロー識別パラダイムの観点から QoS を設定できま

す。この属性は、ゾーン メンバーごとではなく、ゾーン全体で設定できます。

注意 ゾーンベースの QoS がスイッチで実装される場合、その VSAN で interop モードを設定することは

できません。

ゾーンベースのトラフィック プライオリティの設定

Fabric Manager を使用してゾーン プライオリティを設定する手順は、次のとおりです。

ステップ 1 VSAN を開き、[Logical Domains] ペインで、ゾーン セットを選択します。

ステップ 2 [Information] ペインで [Policies] タブをクリックします。

[Information] ペインにゾーン ポリシー情報が表示されます（図 5-37 を参照）。

図 5-37 [Information] ペインの [Zone Policies] タブ

ステップ 3 チェックボックスとドロップダウン メニューを使用して、デフォルト ゾーンの QoS を設定します。

ステップ 4 [Apply Changes] をクリックして、変更を保存します。
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デフォルト ゾーンの QoS プライオリティ属性の設定

QoS プライオリティ属性の設定変更は、関連付けられたゾーンのゾーン セットをアクティブ化したと

きに有効になります。

（注） メンバーが QoS プライオリティ属性が異なる 2 つのゾーンの一部の場合は、より高い QoS プライオリ

ティ値が実装されます。最初の一致エントリが実装されるので、VSAN ベースの QoS ではこの状況は

発生しません。

Fabric Manager を使用してデフォルト ゾーンの QoS プライオリティ属性を設定する手順は、次のとお

りです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 デフォルト ゾーンに QoS プライオリティ属性を設定するには、[Edit] > [Edit Default Zone Attributes] 
を選択します（図 5-38 を参照）。

図 5-38 QoS プライオリティ属性

ステップ 4 [Permit QoS Traffic with Priority] チェックボックスをオンにし、[Qos Priority] ドロップダウン メ
ニューを [low]、[medium]、または [high] に設定します。

ステップ 5 [OK] をクリックして変更を保存します。
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デフォルト ゾーン ポリシーの設定

Fabric Manager を使用してデフォルト ゾーン内のトラフィックを許可または拒否する手順は、次のと

おりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 デフォルト ゾーンに QoS プライオリティ属性を設定するには、[Edit] > [Edit Default Zone Attributes] 
を選択します。

図 5-39 に示す [Modify Default Zone Properties] ダイアログボックスが表示されます。

図 5-39 [Modify Default Zone Properties] ダイアログボックス

ステップ 4 デフォルト ゾーンでトラフィックを許可するには [Policy] ドロップダウン メニューを [permit] に設定

し、デフォルト ゾーンでトラフィックをブロックするには [deny] に設定します。

ステップ 5 [OK] をクリックして変更を保存します。
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ブロードキャスト ゾーン分割の概要

（注） ブロードキャスト ゾーン分割は、Cisco Fabric Switch for HP c-Class BladeSystem および Cisco Fabric 
Switch for IBM BladeCenter ではサポートされていません。

基本ゾーン分割モードでブロードキャスト フレームを設定できます。デフォルトでは、ブロードキャ

スト ゾーン分割はディセーブルになっており、ブロードキャスト フレームは VSAN 内のすべての Nx 
ポートに送信されます。イネーブルの場合、ブロードキャスト フレームは発信側と同じゾーンまたは

複数のゾーンだけに送信されます。ブロードキャスト ゾーン分割は、ホストまたはストレージ デバイ

スがこの機能を使用する場合にイネーブルにします。

表 5-2 に、ブロードキャスト フレームの配信規則を示します。

ヒント FL ポートに接続されている NL ポートがブロードキャスト フレームの発信元とブロードキャスト ゾー

ンを共有する場合、フレームはループ内のすべてのデバイスにブロードキャストされます。

注意 スイッチでブロードキャスト ゾーン分割がイネーブルになっている場合、その VSAN で interop 
モードを設定することはできません。

ブロードキャスト ゾーン分割の設定

Fabric Manager を使用して基本ゾーン分割モードでフレームをブロードキャストする手順は、次のと

おりです。

ステップ 1 VSAN を開き、[Logical Domains] ペインで、ゾーン セットを選択します。

ステップ 2 [Information] ペインで [Policies] タブをクリックします。

[Information] ペインにゾーン ポリシー情報が表示されます（図 5-40 を参照）。

表 5-2 ブロードキャスト要件

アクティブな

ゾーン分割?
ブロードキャスト

がイネーブル?
フレームのブロード

キャスト? 説明

はい はい はい ブロードキャスト フレームの発信元と

ブロードキャスト ゾーンを共有するす

べての Nx ポートにブロードキャスト

します。

いいえ はい はい すべての Nx ポートにブロードキャス

トします。

はい いいえ いいえ ブロードキャストはディセーブルで

す。
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図 5-40 ゾーン ポリシー情報

ステップ 3 [Broadcast] チェックボックスをオンにして、デフォルト ゾーンのブロードキャスト フレームをイネー

ブルにします。

ステップ 4 [Apply Changes] をクリックして、変更を保存します。

LUN ゾーン分割の概要

Logical Unit Number（LUN）ゾーン分割は、Cisco MDS 9000 ファミリのスイッチ固有の機能です。

注意 LUN ゾーン分割は、Cisco MDS 9000 ファミリ スイッチでだけ実装できます。LUN ゾーン分割が

実装されているスイッチでは、interop モードを設定できません。

ストレージ デバイスは、その背後に複数の LUN を持つことができます。デバイス ポートがゾーンの

一部である場合、ゾーンのメンバーはデバイス内のすべての LUN にアクセスできます。LUN ゾーン

分割では、アクセスをデバイスと関連付けられている特定の LUN に制限できます。

（注） LUN 0 がゾーン内に含まれていない場合、標準要件により、LUN 0 への制御トラフィック

（REPORT_LUNS、INQUIRY など）はサポートされますが、LUN 0 へのデータ トラフィック

（READ、WRITE など）は拒否されます。

• ホスト H1 は、S1 内の LUN 2、および S2 内の LUN 0 にアクセスできます。S1 または S2 のその

他の LUN にはアクセスできません。

• ホスト H2 は、S1 内の LUN 1 と 3、および S2 内の LUN 1 だけにアクセスできます。S1 または 
S2 のその他の LUN にはアクセスできません。

（注） ゾーン分割されていない LUN は、自動的にデフォルト ゾーンのメンバーになります。

図 5-41 に、LUN ベースのゾーン分割の例を示します。
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図 5-41 LUN ゾーン分割でのアクセス

LUN ベースのゾーンの設定

Fabric Manager を使用して LUN ベースのゾーンを設定する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 メンバーを追加するゾーンをクリックし、[Insert] アイコンをクリックします。

図 5-42 に示す [Add Member to Zone] ダイアログボックスが表示されます。

図 5-42 [Add Member to Zone] ダイアログボックス

ステップ 4 [Zone By] オプションから [WWN] または [FCID] ラジオ ボタンをクリックして、LUN ベースのゾー

ンを作成します。

ステップ 5 [LUN] チェックボックスをオンにし、参照ボタンをクリックして LUN を設定します。

ステップ 6 [Add] を追加して、この LUN ベースのゾーンを追加します。
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 2
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ストレージ サブシステムへの LUN の割り当て

LUN のマスキングおよびマッピングは、サーバ アクセスを特定の LUN に制限します。LUN マスキン

グがストレージ サブシステムでイネーブルになっていて、Cisco MDS 9000 ファミリ スイッチで追加

の LUN ゾーン分割を実行する場合は、ストレージ サブシステムから各 HBA（ホスト バス アダプタ）

の LUN 番号を取得し、「LUN ベースのゾーンの設定」（P.5-46）の手順に従って LUN ベースのゾーン

を設定します。

（注） 各 HBA の LUN 番号の取得については、該当のユーザ マニュアルを参照してください。

注意 LUN の割り当てを誤ると、データが失われる場合があります。

読み取り専用ゾーンの概要

デフォルトでは、発信側は、発信側とターゲットが同じファイバ チャネル ゾーンのメンバーである場

合、ターゲットのメディアへの読み取りアクセスと書き込みアクセスの両方を持ちます。読み取り専用

ゾーン機能により、メンバーが読み取り専用のファイバ チャネル ゾーン内のメディアに対して読み取

りアクセスだけを持つようにすることができます。

LUN ゾーンを読み取り専用ゾーンとして設定することもできます。

どのゾーンも読み取り専用ゾーンとして識別できます。デフォルトでは、すべてのゾーンは、読み取り

専用ゾーンとして明示的に設定されていない限り、読み取りと書き込みの両方のアクセス権限を持ちま

す。

読み取り専用ゾーンを設定するときは、次の注意事項に従ってください。

• 読み取り専用ゾーンが実装されている場合、スイッチはゾーン内のユーザ データへの書き込みア

クセスを阻止します。

• 2 つのメンバーが読み取り専用ゾーンと読み取りと書き込みゾーンに属する場合は、読み取り専用

ゾーンが優先され、書き込みアクセスは拒否されます。

• LUN ゾーン分割は、Cisco MDS 9000 ファミリ スイッチでだけ実装できます。LUN ゾーン分割が

実装されているスイッチでは、interop モードを設定できません。

• 読み取り専用ボリュームは、オペレーティング システムとファイル システムの一部の組み合わせ

ではサポートされていません（Windows NT または Windows 2000 と NTFS ファイル システムな

ど）。このようなホストからは、読み取り専用ゾーン内のボリュームを利用できません。ただし、

読み取り専用ゾーンがアクティブ化された時点ですでに起動されていたホストは、読み取り専用ボ

リュームを利用できます。

読み取り専用ゾーン機能は、FAT16 または FAT32 ファイル システムが前述の Windows オペレー

ティング システムと組み合わせて使用されている場合は、設計どおりに動作します。
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ゾーン情報の表示
読み取り専用ゾーンの設定

Fabric Manager を使用して読み取り専用ゾーンを設定する手順は、次のとおりです。

ステップ 1 [Zone] > [Edit Local Full Zone Database] を選択します。

[Select VSAN] ダイアログボックスが表示されます。

ステップ 2 VSAN を選択して、[OK] をクリックします。

選択した VSAN の [Edit Local Full Zone Database] ダイアログボックスが表示されます。

ステップ 3 左側のペインの [Zones] をクリックし、[Insert] アイコンをクリックして、ゾーンを追加します。

[Create Zone] ダイアログボックスが表示されます（図 5-43 を参照）

図 5-43 [Create Zone] ダイアログボックス

ステップ 4 [Read Only] チェックボックスをオンにして読み取り専用ゾーンを作成します。

ステップ 5 [OK] をクリックします。

（注） デフォルト ゾーンの読み取り専用オプションの設定については、「デフォルト ゾーン ポリシーの設定」

（P.5-43）を参照してください。

ゾーン情報の表示
Fabric Manager を使用してゾーン情報と統計情報を表示する手順は、次のとおりです。

ステップ 1 VSAN を開き、[Logical Domains] ペインで、ゾーン セットを選択します。

[Information] ペインにゾーンの設定が表示されます。

ステップ 2 [Read Only Violations]、[Statistics] タブ、または [LUN Zoning Statistics] タブをクリックして、選択

されたゾーンの統計情報を表示します。
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拡張ゾーン分割
拡張ゾーン分割
ゾーン分割機能は FC-GS-4 および FC-SW-3 標準に準拠しています。どちらの標準も前セクションで

説明した基本ゾーン分割機能と本セクションで説明する拡張ゾーン分割機能をサポートしています。

ここで説明する内容は、次のとおりです。

• 「拡張ゾーン分割の概要」（P.5-49）

• 「基本ゾーン分割から拡張ゾーン分割への変更」（P.5-50）

• 「拡張ゾーン分割から基本ゾーン分割への変更」（P.5-51）

• 「拡張ゾーン分割のイネーブル化」（P.5-51）

• 「属性グループの作成」（P.5-52）

• 「データベースのマージ」（P.5-52）

• 「ゾーン マージの分析」（P.5-53）

• 「ゾーン マージ制御ポリシーの設定」（P.5-53）

拡張ゾーン分割の概要

表 5-3 に、Cisco MDS 9000 ファミリのすべてのスイッチの拡張ゾーン分割機能の利点を示します。

表 5-3 拡張ゾーン分割の利点

基本ゾーン分割 拡張ゾーン分割 拡張ゾーン分割の利点

複数の管理者が設定変更を同時に行うことができま

す。アクティブ化すると、管理者は別の管理者の設

定変更を上書きできます。

単一のコンフィギュレーション セッ

ションですべての設定を実行できま

す。セッションを開始すると、スイッ

チは変更を行うファブリック全体を

ロックします。

ファブリック全体を 1 つのコ

ンフィギュレーション セッ

ションで設定するため、ファ

ブリック内での整合性が確保

されます。

ゾーンが複数のゾーン セットに含まれる場合、各

ゾーン セットにこのゾーンのインスタンスを作成

します。

ゾーンが定義されると、必要に応じ

て、ゾーン セットがゾーンを参照しま

す。

ゾーンが参照されるため、ペ

イロード サイズが縮小され

ています。データベースが大

きくなるほど、サイズの縮小

も顕著になります。

デフォルト ゾーン ポリシーがスイッチごとに定義

されます。ファブリックをスムーズに動作させるた

め、ファブリック内のスイッチはすべて同一のデ

フォルト ゾーン設定を使用する必要があります。

ファブリック全体でデフォルト ゾーン

設定の実行および交換を行います。

ポリシーがファブリック全体

に適用されるため、トラブル

シューティングの時間が短縮

されます。

スイッチ単位でのアクティブ化の結果を取得するた

め、管理スイッチはアクティブ化に関する複合ス

テータスを提供します。この場合、障害のあるス

イッチは特定されません。

各リモート スイッチからアクティブ化

の結果と問題の特性を取得します。

エラー通知機能が強化されて

いるため、トラブルシュー

ティングが容易です。

ゾーン分割データベースを配信するには、同じゾー

ン セットを再度アクティブ化する必要があります。

再度アクティブ化すると、ローカル スイッチとリ

モート スイッチのハード ゾーン分割のハードウェ

ア変更が影響を受ける場合があります。

ゾーン分割データベースに対して変更

を行い、再度アクティブ化することな

く変更を配信します。

アクティブ化せずにゾーン 
セットを配信するため、ス

イッチのハード ゾーン分割

のハードウェア変更が回避さ

れます。
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基本ゾーン分割から拡張ゾーン分割への変更

基本ゾーン分割モードから拡張ゾーン分割モードに変更する手順は、次のとおりです。

ステップ 1 ファブリック内のすべてのスイッチが拡張モードで動作できることを確認します。

1 つまたは複数のスイッチが拡張モードで動作できない場合、拡張モードへの移行要求は拒否されま

す。

ステップ 2 動作モードを拡張ゾーン分割モードに設定します。この操作を行うことにより、セッションが自動的に

開始され、ファブリック全体のロックが取得され、拡張ゾーン分割データ構造を使用するアクティブお

よびフル ゾーン分割データベースが配信され、ゾーン分割ポリシーが配信され、ロックが解除されま

す。ファブリック内のすべてのスイッチは、拡張ゾーン分割モードに移行します。

ヒント 基本ゾーン分割から拡張ゾーン分割への移行が完了したら、実行コンフィギュレーションを保存するこ

とを推奨します。

MDS 固有のゾーン メンバー タイプ（IPv4 アドレ

ス、IPv6 アドレス、シンボリック ノード名、およ

びその他のタイプ）は他社製スイッチによって使用

される場合があります。マージ時に、MDS 固有の

タイプは他社製スイッチによって誤って解釈される

可能性があります。

メンバー タイプを一意に識別するため

に、ベンダー固有のタイプ値とベン

ダー ID が提供されます。

ベンダー タイプが一意です。

シスコでは interop モードのときに限り、fWWN 
ベースのゾーン メンバシップがサポートされます。

標準 interop モード（interop モード 1）
で fWWN ベースのメンバシップをサ

ポートします。

fWWN ベースのメンバー タ
イプは標準化されています。

表 5-3 拡張ゾーン分割の利点 （続き）

基本ゾーン分割 拡張ゾーン分割 拡張ゾーン分割の利点
5-50
Cisco Fabric Manager Fabric コンフィギュレーション ガイド

OL-19448-01-J、Cisco MDS NX-OS Release 4.2(x)



第 5 章      ゾーンの設定と管理

拡張ゾーン分割
拡張ゾーン分割から基本ゾーン分割への変更

標準では、基本ゾーン分割に変更することを許可していません。ただし、Cisco MDS スイッチではこ

の変更を許可し、その他の Cisco SAN-OS または Cisco NX-OS リリースへのダウングレードおよび

アップグレードを可能にしています。

拡張ゾーン分割モードから基本ゾーン分割モードに変更する手順は、次のとおりです。

ステップ 1 アクティブおよびフル ゾーン セットに拡張ゾーン分割モード固有の設定が含まれていないことを確認

します。

このような設定が存在する場合は、この手順を進める前にこれらの設定を削除します。既存の設定は、

削除しておかなくても Cisco NX-OS ソフトウェアにより自動的に削除されます。

ステップ 2 動作モードを基本ゾーン分割モードに設定します。この操作を行うことによって、セッションが自動的

に開始され、ファブリック全体のロックが取得され、基本ゾーン分割データ構造を使用するゾーン分割

情報が配信され、設定変更が適用され、ファブリック内のすべてのスイッチのロックが解除されます。

ファブリック内のすべてのスイッチは、基本ゾーン分割モードに移行します。

（注） 拡張ゾーン分割をイネーブルにして Cisco SAN-OS Release 2.0(1b) および NX-OS 4(1b) 以降

を実行しているスイッチが Cisco SAN-OS Release 1.3(4) 以前にダウングレードされた場合、

スイッチは基本ゾーン分割モードになり、ファブリックに参加できません。これは、ファブ

リック内のその他すべてのスイッチが拡張ゾーン分割モードのままであるためです。

拡張ゾーン分割のイネーブル化

デフォルトでは、拡張ゾーン分割機能は Cisco MDS 9000 ファミリのすべてのスイッチでディセーブル

です。

Fabric Manager を使用して VSAN 上で拡張ゾーン分割をイネーブルにする手順は、次のとおりです。

ステップ 1 VSAN を開き、[Logical Domains] ペインで、ゾーン セットを選択します。

[Information] ペインにゾーン セットの設定が表示されます。

ステップ 2 [Enhanced] タブをクリックします。

現在の拡張ゾーン分割設定が表示されます。

ステップ 3 [Action] ドロップダウン メニューから、[enhanced] を選択して、この VSAN で拡張ゾーン分割をイ

ネーブルにします。

ステップ 4 [Apply Changes] をクリックして、変更を保存します。
5-51
Cisco Fabric Manager Fabric コンフィギュレーション ガイド

OL-19448-01-J、Cisco MDS NX-OS Release 4.2(x)



第 5 章      ゾーンの設定と管理

拡張ゾーン分割
属性グループの作成

拡張モードでは、属性グループを使用して属性を直接設定できます。

属性グループの設定については、『Cisco MDS 9000 Family CLI Configuration Guide』を参照してくだ

さい。

データベースのマージ

マージの動作は、ファブリック全体のマージ制御設定によって異なります。

• 制限：2 つのデータベースが同一でない場合、スイッチ間の ISL は分離されます。

• 許可：2 つのデータベースは、表 5-4で指定されたマージ規則を使用してマージされます。

注意 隣接ファブリックで FabricWare を実行している Cisco MDS 9020 スイッチがある場合は、ファブ

リックをマージする前に Cisco SAN-OS を実行しているすべての MDS スイッチで pWWN 以外の

すべてのタイプを削除してください。

マージ プロセスは次のように動作します。

1. ソフトウェアがプロトコル バージョンを比較します。プロトコル バージョンが異なる場合、ISL 
は分離されます。

2. プロトコル バージョンが同じ場合、ゾーン ポリシーが比較されます。ゾーン ポリシーが異なる場

合、ISL は分離されます。

3. ゾーン マージ オプションが同じである場合、マージ制御設定に基づいて比較が行われます。

a. 設定が「制限」の場合、アクティブ ゾーン セットとフル ゾーン セットが同じになる必要があ

ります。同じでない場合、リンクは分離されます。

b. 設定が「許可」の場合、マージ規則を使用してマージが行われます。

表 5-4 データベースのゾーン マージ ステータス

ローカル データベース 隣接データベース

マージ ステー

タス マージ結果

データベースに、名前は同じであるが1、ゾーン、エイリ

アス、および属性グループの異なるゾーン セットが含ま

れる。

1. 拡張ゾーン分割モードで、アクティブ ゾーン セットは interop モード 1 で名前を持ちません。ゾーン セット名は、
フル ゾーン セットでだけ存在します。

成功 ローカル データベースお

よび隣接データベースの

結合。

データベースに、名前は同じ 1 であるが、メンバーの異

なるゾーン、ゾーン エイリアス、またはゾーン属性グ

ループ オブジェクトが含まれる。

失敗 ISL は分離されます。

空 データあり 成功 隣接データベース情報が

ローカル データベースに

読み込まれます。

データあり 空 成功 ローカル データベース情

報が隣接データベースに

読み込まれます。
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ゾーン マージの分析

Fabric Manager を使用してゾーン マージの分析を実行する手順は、次のとおりです。

ステップ 1 [Zone] > [Merge Analysis] を選択します。

図 5-44 に示す [Zone Merge Analysis] ダイアログボックスが表示されます。

図 5-44 [Zone Merge Analysis] ダイアログボックス

ステップ 2 [Check Switch 1] ドロップダウン リストで、最初に分析するスイッチを選択します。

ステップ 3 [And Switch 2] ドロップダウン リストで、2 番めに分析するスイッチを選択します。

ステップ 4 [For Active Zoneset Merge Problems in VSAN Id] フィールドに、ゾーン セット マージに失敗した 
VSAN の ID を入力します。

ステップ 5 [Analyze] をクリックして、ゾーン マージを分析します。

ステップ 6 [Zone Merge Analysis] ダイアログボックスから分析データをクリアするには、[Clear] をクリックしま

す。

ゾーン マージ制御ポリシーの設定

マージ制御ポリシーの設定については、『Cisco MDS 9000 Family CLI Configuration Guide』を参照し

てください。

ゾーンの Generic Service アクセス権限設定は、Generic Service（GS）インターフェイス経由でのゾー

ン分割操作を制御するために使用されます。ゾーンの Generic Service アクセス権限は、読み取り専用、

読み取りと書き込み、またはなし（拒否）にすることができます。

Generic Service（GS）設定を設定する手順は、次のとおりです。

コマンド 目的

ステップ 1 switch# config t 設定モードに入ります。
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ダウングレード用のゾーン データベースの圧縮
Cisco SAN-OS Release 3.0(1) 以前では、VSAN あたり 2000 ゾーンだけがサポートされます。VSAN 
に 2000 を超えるゾーンを追加した場合、以前のリリースにダウンロードすると制限超過分のゾーンが

失われる可能性のあることを示す、コンフィギュレーション チェックが登録されます。コンフィギュ

レーション チェックを回避するには、超過分のゾーンを削除し、VSAN のゾーン データベースを圧縮

します。超過分のゾーンを削除した後、ゾーン数が 2000 以下になれば、圧縮プロセスによって新しい

内部ゾーン ID が割り当てられ、設定は Cisco SAN-OS Release 2.x 以前によってサポートされます。こ

の手順は、2000 を超えるゾーンを含む、スイッチ上のすべての VSAN で実行します。

（注） スイッチが VSAN あたり 2000 を超えるゾーンをサポートしていても、その隣接スイッチがサポートし

ていない場合、マージは失敗します。また、スイッチが VSAN あたり 2000 を超えるゾーンをサポート

していても、ファブリック内のすべてのスイッチが VSAN あたり 2000 を超えるゾーンをサポートして

いない場合には、ゾーン セットのアクティブ化に失敗することがあります。

ダウングレード用のゾーン データベースの圧縮については、『Cisco MDS 9000 Family CLI 
Configuration Guide』を参照してください。

デフォルト設定
表 5-5に基本ゾーン パラメータのデフォルト設定を示します。

ステップ 2 switch(config)# zone gs read vsan 3000 gs のアクセス権限の値を、指定された 
VSAN で読み取り専用として設定します。

switch(config)# zone gs read-write vsan 3000 gs のアクセス権限の値を、指定された 
VSAN で読み取りと書き込みとして設定

します。

switch(config)# no zone gs read-write vsan 
3000

gs のアクセス権限の値を、指定された 
VSAN でなし（拒否）として設定します。

表 5-5 デフォルトの基本ゾーンパラメータ

パラメータ デフォルト

デフォルト ゾーン ポリシー すべてのメンバーで拒否。

フル ゾーン セット配信 フル ゾーン セットは配信されません。

ゾーン ベースのトラフィック プライオリティ 低。

読み取り専用ゾーン すべてのゾーンで読み取りと書き込み属性。

ブロードキャスト フレーム すべての Nx ポートに送信。

ブロードキャスト ゾーン分割 ディセーブル。

拡張ゾーン分割 ディセーブル。
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